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2 Foreword  

 
Dear Customer! 
 
Thank you for choosing a product manufactured by us! 
Please take your time to read this manual carefully. Please pay special attention to the safety 
instructions. 
This is the condition for safe handling and safe operation of the system and its components. 
If you have any questions that you do not find answered in this manual, please call us and 
we will be pleased to assist you. In addition, we always welcome any suggestions or 
proposals for improvement. 
Our products undergo constant advanced development; therefore there may be minor 
differences between your system and the illustrations given in this Operating Manual. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 2021 
Opsytec Dr. Gröbel GmbH 
Am Hardtwald 6-8 
D - 76275 Ettlingen 
Tel.: +49(0)7243 / 9 47 83-50 
Fax: +49(0)7243 / 9 47 83-65 
info@opsytec.de 
 
All rights reserved. Reprinting, including excerpts, is only permitted with the written consent 
of Opsytec Dr. Gröbel GmbH.           
 
This is a translation of the original operating manual. 
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3 Quick guide spectroradiometric measurement  

The quick guide should demonstrate the function of the spectrometer to you with the help of 
an operating sequence. The objective of the quick guide is that you should have a measured 
spectrum on the screen at the end.  
The goal of the Quick Start Guide is that you end up with a measured spectrum on your 
screen. 
 

1. Start the SRpro program. 
The program starts with a welcome screen and starts the connection to the 
spectrometer. 

 

When starting for the first time, set the user to Power user if necessary. 
See Start > Options > UserThe  
password can be found as an attachment to this manual. 

2. Check in the main window that the following buttons are active:  

 Dark measurement (on) 

 Absolute calibration 

3. Hold the diffuser against a light source 

 Start the measurement 

A status window is opened. Here, the current integration time is displayed. 
The integration time is changed several times in order to achieve a recording 
level of approx. 90%. When the correct integration time is found, the window 
disappears and the actual measurement is started.  

4. Now, a spectrum should be displayed on your screen after a few seconds.  
5. If necessary, continue with manual dark measurement. 

After that, your spectrometer is ready for operation. 
 
Notes for calibrated measurements: 

 

 

In order to carry out a calibrated measurement, please select the button “Relative 
spectral correction” or “Absolute spectral correction”. The selection of one of 
these two buttons will release the drop-down list for the correction file . 
In this list, select one of the correction files that have been delivered with your 
spectrometer. Please note that the file must match with the input optics used 
(fibre optics cable, U-sphere, diffuser, etc.). 

In case of absolute irradiance measurements, we recommend using dark measurement, 
scattered light correction and averaging over 3 to 20 measurements. 
 

 Dark measurement  

 
Stray light correction 

 Averaging over 3 to 20 measurements 
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4 Quick guide transmission / reflection measurement  

The short instructions are intended to demonstrate the function of the spectrometer by 
means of an operating sequence. The aim of the short instructions is that you have a 
measured spectrum on your screen at the end.  
 
 

1. Start the SRpro program. 
The program starts with a welcome screen and starts the connection to the 
spectrometer. 

 

When starting for the first time, set the user to Power user if necessary. 
See Start > Options > UserThe  
password can be found as an attachment to this manual. 

2. Check in the main window that the following buttons are active:  

 Dark measurement (automatic) 

 
No calibration 

 
Transmission measurement / Reflection measurement 

 
Flash lamp on 

 
Stray light correction on (only for reflection measurements) 

 
3. Connect the light guide for transmission or reflection 

 
4. Set the integration time and the number of measurements. Typical: 

a. for transmission measurements e.g. 200 ms and 10 measurements 
b. for reflection measurements with an integrating sphere e.g.30000 ms and >3 

measurements  
5. Start the measurement  

 Start the measurement 

After the dark measurement, which takes a few seconds, you will be prompted to 
start the 100% measurement (baseline). 

 
6. Then insert the sample (Note Sample measurement). 

 
7. After that, the measurement appears on the screen. 

 
We recommend using dark measurement, stray light correction and averaging over 10 to 100 
measurements. 
 

 Dark measurement (manual) 

 
Stray light correction for irradiance and baseline measurements 

 Averaging  
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5 Guidelines and standards  

 

 

The system is machinery under Annex II A of the Machinery Directive 
and is therefore delivered with a declaration of conformity and with a 
CE mark (in accordance with the Machinery Directive). 

 

Directives 

EC Directives 06/42/EC (Machinery) (partially observed) 
2014/30/EC (EMC) 
2014/35/EC (Low voltage) 

Harmonised standards 

EN ISO 12100:2010 Safety of Machinery – 
General Principles for Design 
Risk Assessment and Risk Reduction 

EN 60204-1:2006 
+A1:2009 
+AC:2010 

Safety of Machinery –  
Electrical Equipment of Machines –  
Part 1: General Requirements  

EN 61000-6-2:2005 Electromagnetic Compatibility (EMC) –  
Part 6-2: Immunity for Industrial Environments  

EN 61000-6-4:2007 
+ A1:2011 

Electromagnetic Compatibility (EMC) –  
Part 6-4: Emission Standard for Industrial Environments 
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6 Identification  

6.1 Manufacturer, Ordering of Spares and Customer Service 
Opsytec Dr. Gröbel GmbH 
Am Hardtwald 6-8 
D - 76275 Ettlingen 
Tel.: +49(0)7243 / 9 47 83-50 
Fax: +49(0)7243 / 9 47 83-65 
info@opsytec.de 
www.opsytec.de 

6.2 Change history  

 

We reserve the right to make changes in content. Opsytec Dr. Gröbel 
GmbH is not liable for any errors in this documentation. No liability shall 
be accepted for indirect damages arising from the delivery or use of this 
documentation, in as far as this is legally permissible. 

 
Version Changed by Date Change 

1.43 Paravia 15.08.2014 Creation 

1.44 Paravia 10.07.2015 Software update 4.0 

2.0.1E Paravia 21.08.2017 Software update 5.0, pixel count 

2.0.2E Paravia 19.12.2017 Software update 5.1, EXCEL export 

2.0.3E Paravia 26.03.2019 Red. Changes 

 

6.3 Copyright  

 

Opsytec Dr. Gröbel GmbH shall retain the copyright for these operating 
manual. The operating manual is intended for the owner/operator and his 
personnel. 
Copyright in accordance with DIN ISO 16016: 
Reproduction and copying of this document, use and disclosure of its 
contents are prohibited unless expressly authorized.  
Non-compliance may result in a claim for damages. All rights reserved in 
case of registration of patent, utility patent, or design patent. 
Contraventions may be subject to prosecution. 

6.4 Device identifier  
For internal use at customer site: 

Description of machinery: …………………….. 

Year of construction: …………………….. 

Machine No. …………………….. 

Project no. ……………………... 
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6.5 Intended use  
 
The system is intended for industrial use only. It is forbidden to use the devices in 
explosive environments. 
• Installation, commissioning, operation, maintenance and service works must solely be 

performed by trained and educated, qualified personnel, which observes all safety 
regulations and standards. 

• Responsibility: Damages resulting from unintentional or unauthorized interventions 
terminate every right, to raise warranty or liability claims against the manufacturer. 

• Guarantee exclusion: The use of any non-original parts voids the guarantee. 
• Environmental protection: Defect parts, which may contain environmentally harmful 

substances, must be disposed of accordingly. 
• Operation is only permitted in a dry environment. The installation is horizontal. 
• Only suitable for indoor operation. 
• Before opening, the system must be disconnected from the voltage and it must be 

checked that there is no voltage. 
• Wear gloves for servicing, cleaning and replacing the light guides and optical 

components. 
• Do not clean the system when it is in operation. 
• The housing must not be opened by the user. The optically active surface must not be 

touched. 
• Gloves must be worn for cleaning the optically active surface. 
• The SR600 / SR900 is a highly sensitive optical measuring instrument. It must not be 

subjected to shocks. 
• When using the system, light and UV radiation may be reflected and scattered by the 

measuring head. If necessary, suitable protective measures must be used to protect 
against radiation. 

• Any other use than the above mentioned, results in damages to the product. 
Furthermore, it is associated with risks such as short circuits, fire and electric shocks. 
The entire device must not be changed and/or modified! The safety notes must be 
observed at all times. 

6.6 Foreseeable misuse  
The following is considered foreseeable misuse: 

• Operation of the device without safety devices and equipment. 

• Activities of uninstructed personnel on the device. 

• Non-compliance with the operating instructions of the owner/operator. 

• Ignoring of the operating manual. 

• Any other use outside the intended specified use. 
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6.7 Legal information  
 

6.7.1 Limitation of liability  

All the information in this manual was compiled with consideration of the currently valid 
standards and regulations, of the technical standard and our long-standing knowledge 
and experience. 
The manufacturer shall not be liable for damage in the event that: 

• This manual is ignored, 

• The device is improperly used, 

• Untrained personnel is deployed, 

• Untrained personnel operates the machine incorrectly, 

• Unauthorized modifications are made, 

• Technical changes are made, 

• Non-approved spare parts are used. 
We shall not be liable for common faults of the device caused by power outage or failure 
of the control system. 
The actual scope of delivery may be different than the explanations and pictures in this 
manual in case of special versions, when additional options are ordered or due to the 
latest technical changes. 
The obligations agreed in the delivery contract, as well as the legal requirements valid at 
the time the contract was concluded shall apply. 
 

6.7.2 Declaration of Conformity  

The declaration of conformity is in the annex or can be requested from the manufacturer.  
 

6.7.3 Warranty condition en  

The warranty terms and guarantee conditions are governed by the German Civil Code 
(BGB). The warranty period is one year unless otherwise agreed in the purchase 
documents. 
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7 General  

7.1 Information about this manual  
This manual intends to make handling of this system and its components safe and 
efficient. The manual is part of the system and must be kept in its immediate vicinity 
where it is accessible for the personnel at any time. 
This documentation contains the necessary information for the intended use of the 
described system. It is intended for technically qualified personnel who have been 
especially trained for operation, laboratory use, quality assurance, service and repair. 
The personnel must have read this manual carefully and understood its content before 
commencing any work. The basic condition for safe working is observation of all stated 
safety information and operating instructions in this manual. 
Knowledge and technically faultless implementation of the instructions, safety 
requirements, safety information and warnings are a condition for safety in operation, 
service and repair. Only qualified personnel has the required professional knowledge to 
apply the safety requirements, safety information and warnings stated in this operating 
manual in a general way correctly in a concrete situation. 
In addition, the local accident prevention regulations and general safety regulations apply 
for the area of application of the system. 
Illustrations in this manual serve the purpose of general understanding; they may differ 
from the actual version. 
Apart from this manual the instructions for the installed components included in the 
appendix apply. 
This operating manual cannot take any possible case of maintenance into account. If you 
need further information or if special problems occur that are not treated extensively 
enough in this manual please request the required information from the manufacturer. 
 
 

 

For ease of description, the above components are collectively referred 
to as the system. 
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7.2 Information about the symbols  
7.2.1 Safety instructions  

In this manual, safety information is indicated by means of symbols. Safety information is 
preceded by signal words that indicate the scope of risk. 
To avoid accidents and damage to persons or property, always follow the information and 
act prudently. 
Throughout the text, you will find the following pictograms with the following meanings: 
 

 

 DANGER 

Imminent danger 
Possible consequences: Death or most severe injuries. 

• Prevention 

 

 

 WARNING 

Dangerous situation  
Possible consequences: Death or most severe injuries. 

• Prevention 

 

 

 CAUTION 

Possible situation  
Possible consequences: Minor or slight injury. Sometimes also used as a 
warning of material damage. 

• Prevention 

 

 

Note 
Information about the application or useful, important information 

 

7.2.2 Prohibition signs  

 

General "prohibition sign 
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7.2.3 Warning signs  

 

 

Warning against optical radiation  
(such as UV, IR, or visible radiation). 

 

Warning of electricity! 

 

7.2.4 Attention  

 

 

7.2.5 Optional function  

* Optional functions, not available for every system  
 

 

Wear eye protection!  

 

Disconnect mains plug from electrical outlet! 

 

Disconnect before carrying out maintenance or repair! 

 

Use hand protection! 

 

Refer to instruction manual/booklet 
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7.3 Owner/operator information  
The System is used in the commercial sector. The owner/operator of the system is 
therefore subject to the legal obligations concerning work safety. 
In addition to the safety information in this manual, the generally applicable regulations 
valid for the application area of the system concerning safety, prevention of accidents and 
for protection of the environment must be noted and complied with. 
The following applies in particular: 

 The owner/operator must acquire information about the valid occupational health and 
safety information and in a risk assessment determine additional hazards incurred due 
to the special operating conditions at the location of use of the system. He must 
implement these in the form of operating instructions for operation of the system and 
specifically for the individual work stations. 

 The owner/operator is obliged to check during the entire lifetime of the system whether 
the operating instructions that he generated comply with the current status of the 
regulations and update them if necessary. 

 The owner/operator must assign and define the responsibilities for installation, 
operation, rectification of faults, service and cleaning unambiguously. 

 The owner/operator must ensure that all personnel dealing with the system have read 
and understood this manual. Furthermore, he is obliged to provide personnel training 
in regular intervals and provide information about risks. 

 The owner/operator must provide the required personal protective equipment for his 
personnel. Furthermore, the owner/operator is responsible that the system is always in 
faultless technical condition. To ensure this, the service intervals specified in this 
manual and in the technical documents for the individual systems must be observed 
and all safety installations must be checked regularly for function and completeness. 

 The owner/operator must have all safety devices checked regularly for function and 
completeness. 

 The owner/operator must ensure that the operating personnel have knowledge about 
first aid measures and local rescue installations. 
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7.4 Personnel requirements  
7.4.1 Qualifications  

Below, this manual lists the qualifications of the personnel for the various areas of activity: 
 

7.4.2 Electrically skilled person 

Due to their professional training, knowledge and experience and knowledge of the 
relevant standards and regulations, electrically skilled persons are able to carry out work 
on electrical systems and to recognize and avoid risks independently. 
Electrically skilled persons are specially trained for the work environment where they are 
working and they know the relevant standards and regulations. Electrically skilled persons 
must fulfil the requirements of the valid legal regulations for accident prevention. 

7.4.3 Qualified person 

Qualified persons are trained or can be trained by Opsytec Dr. Gröbel GmbH in extended 
operation and parameterization of the system as well as in execution of preventive 
service work.  
In addition, due to their technical training, knowledge and experience and knowledge of 
the relevant standards and regulations, they are able to carry out work they have been 
assigned and to recognize and avoid possible risks independently. 

7.4.4 Operators 

Operators use and operate the system in the scope of the intended use. They are trained 
by the owner/operator in the work assigned to them and informed about possible risks. 
 

7.4.5 Training and Qualification of Personnel 

In regular instructions and training, operating personnel must be informed about the 
special risks when working with and handling the system.  
The instruction and training should have the following content: 

 Hazards when working with the system in normal operation. 
 Hazards in connection with service, repair and cleaning activities. 
 Conduct to minimize consequences of accidents. 
 Conduct in case of accidents. 
 Rescue of injured persons. 
 Working without personal protective equipment may cause health damage. The 

company supervisor is instructed to pay attention that personnel are wearing personal 
protective equipment. 

 Particular hazards when working on the electrical system. 
 
Instruction and training must be carried out in regular intervals by the owner/operator. For 
better tracking, execution of instruction and training should be recorded. 
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7.5 Personal Protective Equipment 
The purpose of personal protective equipment is to protect the personnel from risks that 
might affect his safety or health when working. 
When executing various activities on and with the system, the personnel must wear 
personal protective equipment. This will be pointed out again in the individual chapters of 
this manual. Below, personal protective equipment is explained: 
 

7.5.1 Protective Gloves 

Protective gloves are used to protect hands from visible and invisible radiation, friction, 
abrasion, stabs and deep injuries. 
 

7.5.2 Protective Googles 

Protective googles are used to protect eyes from intense visible and invisible radiation.  
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8 Safety instructions and residual risk  

8.1 General  
The system is state-of-the-art and has been built in compliance with recognized safety 
regulations. Nonetheless, its use may constitute risks for life and limb of the operating 
and repair personnel (service personnel) or third parties or impairments to the machine. 
Operate the system only when its safety devices are in faultless condition. Disruptions 
that impair its safety must be rectified at once. 
The following safety information must be strictly observed to prevent damage to the 
machine and personal injury! 
 

 

 WARNING 

Risk of injury when personnel do not read the operation manual! 
Prior to commissioning and operation, read the operation manual 
completely. Read all safety information and instructions. Negligence 
concerning safety information and instructions may cause electric shock 
and/or severe injuries. 
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8.2 Safety instructions relating to normal operation  
 

 

 CAUTION 

Risk of damage 
• The SR600 is calibrated. Do not expose the instrument to shocks. 
• CAUTION: Opening the housing will result in loss of calibration. 

 

 

 

 CAUTION 

Risk of damage 
• Skin grease and dirt are absorbent in the UV and visible spectral 

range. 
• Avoid fingerprints on the optically active sensor surface. If 

necessary, clean the components carefully with isopropanol. 

 

 

 CAUTION 

Risk of damage 
Special guidelines must be followed when using an optical fiber. 
Avoid: 
• Touching the end faces with the fingers 
• Storage on dusty surfaces 
• Bumping against hard surfaces 
• Immersion in e.g. contaminated liquids. 
• small bending radii (200mm) 

 

 

 CAUTION 

Risk of damage 
• Hand-tighten the knurled screws of the SMA-905 light guides. 

 

 

 

 WARNING 

Fire hazard! 
A high irradiance, which can ignite combustible materials in case of 
continuous irradiation, is achieved at the output of the light guide of 
optional flash lamps. Remove all combustible materials and observe the 
irradiation time and material temperature.  
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8.3 Radiation safety  

 

 WARNING 
Risk of eye injury 
The SR600/SR900 can optionally be equipped with xenon flash lamps. There is 
then a risk of photochemical or thermal damage to the eye, retinal damage and 
burns. Visible (blue) light can cause photochemical damage to the eye. If 
necessary, use suitable protective goggles when operating the unit. The 
operating personnel must be trained appropriately. 
Recommended protective equipment: 

- Gloves 
- Safety glasses, no transmission below 400 nm 

 
Do not look into the light source and do not expose skin to radiation! 
Avoid reflections of the radiation into the eye! 
The installation should be designed in such a way as to prevent a direct view 
into the light guide receptacles and the light guides. 
The devices were classified in risk group 3 according to DIN EN 62471:2009-03 
"Photobiological safety of lamps and lamp systems".  

 

The customer is responsible for the risk evaluation for the workplace. Therefore, 
measurements / evaluations in accordance with DIN EN 14255-1:2005-06 “Measurement 
and assessment of personal exposures to incoherent optical radiation - Part 1: Ultraviolet 
radiation emitted by artificial sources at the workplace” are required.  
The DIN 14255-1 itself does not contain any thresholds. These are determined in the 
guideline “2006/25/EG of the European Parliament and the Council on the minimum 
health and safety requirements regarding the exposure of workers to the risks arising 
from physical agents (artificial optical radiation)”. 
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8.4 Safety instructions relating to service and repair work  
 

 
 

 WARNING 

Risk of injury when touching live parts 
Before opening the system, disconnect all components from the supply 
voltage and check that no voltage is present. 

 

 

 CAUTION 

Risk of damage 
• The SR600 is calibrated. Do not expose the instrument to shocks. 
• CAUTION: Opening the housing will result in loss of calibration. 
• Switch off the control unit prior to connecting / disconnecting 

accessories. Due to the operating voltage of the unit, the 
accessories can get damaged. 

 

 

 CAUTION 

Risk of damage 
• Skin grease and dirt are absorbent in the UV and visible spectral 

range. 
• Avoid fingerprints on the optically active sensor surface. If 

necessary, clean the components carefully with isopropanol. 

 

 

 CAUTION 

Risk of damage 
Special guidelines must be followed when using an optical fiber. 
Avoid: 
• Touching the end faces with the fingers 
• Storage on dusty surfaces 
• Bumping against hard surfaces 
• Immersion in e.g. contaminated liquids. 
• small bending radii (200mm) 

 

 

 CAUTION 

Risk of damage 
• Hand-tighten the knurled screws of the SMA-905 light guides. 
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 Service, repair and cleaning work must only be carried out by authorized and 
specifically trained professionals. The system must be power-free and secured before 
major work is carried out (including cleaning). 

 Carry out the prescribed setting, service and inspection work according to schedule. If 
you need further information or if special problems occur that are not treated 
extensively enough in this manual The housing must not be opened by the user. The 
optically active surface must not be touched. 

 Gloves must be worn for cleaning the optically active surface. 
 The SR600/SR900 is a highly sensitive optical measuring instrument. It must not be 

subjected to shocks. 
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9 Description of the system and function overview  

The compact SR900 spectroradiometer is a high-resolution measuring system for fast 
and precise measurements in the UV, visible spectral range and IR. The measuring range 
extends from 200 nm to 1100 nm. The spectroradiometer consists of an array 
spectrometer without moving parts and a silicon array with 2048 pixels. The spectral 
resolution is 2.3 nm (pixel pitch 0.4 nm).  
The SR900 is combined with an SMA-905 quartz optical fiber and our radiometric probes 
for irradiance and illuminance measurements. With trigger input and output, the SR900 is 
also suitable for automated measurements. 
The UV-VIS SR600 spectrometer is a modular measuring system for fast and precise 
measurements in the UV and visible spectral range. The main unit consists of a 
polychromator without any moving parts and a silicon photo diode array. We also offer a 
wide assortment of accessories for the SR600 spectrometer that can be combined with 
customer-specific extensions. The integrated shutter enables automatic dark current 
correction. Control and data evaluation are carried out with the SR600 spectral software. 
The SR600 is also suitable for automated measurements with trigger input and output. A 
high dynamic range is achieved by a special multiple measurements of up to 105:1. The 
spectral resolution of the spectrometer permits the clear resolution of the two Hg lines at 
577 and 579 nm. 
The SR900 and SR600 are traceable to the PTB factory calibration. DAkkS testing in our 
accredited laboratory is optionally available. The devices thus allow accurate 
spectroradiometric measurements for the evaluation of irradiances and illuminances, 
biological efficacy and color measurements. Due to the low stray light design, a high 
sensitivity in the UV range is achieved. Control and data evaluation are performed with 
the SRpro spectral software.  
With Version 4.0, an enhanced user management is introduced. Now, it’s possible to 
switch the user interface between a main user, with all features, and a restricted user 
permanently. For switching a password is required, which accompanies this document. It 
is therefore possible to use the SR600 in a qualified environment. 
 
The user rights differ as follows: 

Right User Main user 

Perform measurements yes yes 

Change settings, that may change the result  
 

no 
 

yes 

Change of integration time  yes yes 

Change calibration  no yes 

Saving erroneous measurements (pdf) (see 
threshold settings) 

 

no 
 

yes 

Automatic Save as PDF yes no 

Automatic review included in report (pdf) yes no 

Manipulation of measurements / calculations of 
measurements 

 

no 
 

yes 

Change user permanently no yes 

Change Password no no 



9 Description of the system and function overview 2 3   
 

 

 
With (limited) user account it is not possible to change the following settings: 
  

• Change correction file 
• Change of spectral correction / relative / absolute  
• Change offset correction 
• Change Dark Measurement 
• Perform data manipulation 
• Change Dynamics Measurement 
• Overwrite files accidentally 
• Change printer settings and protocol settings  

 

9.1 General Product Description:  
 

• Spectral range 200-1100 nm or 200-800 nm 
• Order filtering 
• Spectral software for color measurement, radiometric and effect-related measurements 
• Simple validation through user concept  
• Extensive range of accessories 

 

9.2 The following components are supplied:  
 

• Spectroradiometer 
• Spectrometer software SRpro 
• USB cable 
• this documentation 
• optional: fiber optic cable 
• optional: sensor head 
• optional: integrating sphere reflection attachment 

 

 

For ease of description, the above components are collectively referred 
to as the system. 

 
The following components are required by the customer: 

 
• PC with  10 
• Free USB interface 
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10 Commissioning  

• Unpack all components and remove the packing materials.  
• Connect the light guide (end ferrule) to the SR600/SR900 and hand-tighten the knurled 

screw. 
• Connect the SR600/SR900 to mains voltage and switch it on 
• Install the drivers and software (see below) 
• Connect the SR600/SR900 to the PC. 

 

 

 WARNING 

Risk of damage  
The light conductors are very sensitive and must not be bent or severely 
bent. 
A minimum bending radius of 200 mm must be observed.  

10.1 Software installation  
- Connect the USB stick or CD to the PC and double-click Setup.exe. 
- Follow the installation instructions on the screen and confirm the installation of the 

drivers. 
 

10.2 Removing SRpro  
If necessary, you can remove SRpro from your computer. 
The following options are available for this purpose: 

- Click on "Start" in the Windows Start menu and select "Programs > SRpro > 
Remove SRpro". 

- Select "Settings > Control Panel" in the Windows "Start" menu. Double-click 
- click on "Software" in the Control Panel. Select "SRpro " in the dialog box 
- "Software Properties" on the "Install/Uninstall" tab and click the "Add/Remove" 

button. 
 
 

10.3 Installing device drivers under Windows 8 / 10  
In case of problems: 
64-bit versions of Windows 10 and 8 include a “driver signature enforcement” feature. 
They’ll only load drivers that have been signed by Microsoft. To install less-than-official 
drivers, old unsigned drivers, or drivers you’re developing yourself, you’ll need to 
disable driver signature enforcement. 
 
You can use the advanced boot options menu to boot Windows 10 with driver signature 
enforcement disabled. This isn’t a permanent configuration change. The next time you 
restart Windows, it will boot with driver signature enforcement enabled—unless you go 
through this menu again. 
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To do this, get to the Windows 8 or 10 advanced boot options menu. For example, you 
can hold down the Shift key while you click the “Restart” option in Windows. Your 
computer will restart into the menu. 

 

Select the “Troubleshoot” tile on the Choose an option screen that appears. 

 

Select “Advanced options”. 
 

 
 
Click the “Startup Settings” tile. 

https://www.howtogeek.com/126016/three-ways-to-access-the-windows-8-boot-options-menu/
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Click the “Restart” button to restart your PC into the Startup Settings screen. 
 

 
 
Type “7” or “F7” at the Startup Settings screen to activate the “Disable driver signature 
enforcement” option. 
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Your PC will boot with driver signature enforcement disabled and you’ll be able to install 
unsigned drivers. However, the next time you restart your computer, driver signature 
enforcement will be disabled—unless you go through this menu again. You’re now free 
to install drivers that haven’t been officially signed by Microsoft. 
 
 
During the installation of the driver you will be prompted. Press "Install this driver 
software anyway". 

 

 

 

http://www.deskmodder.de/wiki/index.php/Datei:Digital_unsignierte_treiber_installieren_windows_8_7.jpg
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11 Operation  

11.1 The controls  
The operating elements are labeled in the following figure. In the following, the individual operating 
elements are presented in detail and their function is explained.  

 
 
 

  
 
 

11.2 The spectral diagram  
At the top left of the screen you can see the units, at the bottom right the level. The largest 
part of the screen is the graphical representation of the spectrum. In horizontal direction the 
wavelength is displayed, in nm and in vertical direction the spectral irradiance. 
The lower part of the screen contains the display of the current cursor position and the 
controls for managing multiple spectra. 

 

 
 
By clicking and holding the left mouse button, a rubber band can be drawn. The section when 
releasing the left mouse button is zoomed out and displayed enlarged in the spectral window. 

 

Toolbar 

Spectral diagram Status bar 

Menu bar 

Info area 
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Pan function  
The Pan function is used to move the graphic. To activate the pan function, the CTRL key must 
be held. When the mouse pointer is in the graphic, it changes the shape to a cross. Now the 
graphic can be moved by pressing and holding the left mouse button.  
Context menu of the spectral window  
Clicking the right mouse button within the graphic opens the context menu.  

 
 

Under Zoom Auto. Scale can be switched on/off, return to the full range or display the ordinate 
10% or 20% larger than the maximum signal.  

 
If the menu item "Scan graph" is selected, a crosshair is displayed as soon as the mouse is in 
the spectral display. This crosshair follows the mouse movement and is always assigned to the 
wavelength of the mouse position.  

 
Under the item "Edit" the spectral graph can be copied to the clipboard or saved as a bitmap 
file. Using these functions, it is possible to transfer the spectral display to a word processing 
program for documentation purposes.  
 
The bottom item "Start measurement" starts a new measurement.  
If the menu item "Scan graph" is selected, a crosshair is displayed as soon as the mouse is in 
the spectral display. This crosshair follows the mouse movement and is always assigned to the 
wavelength of the mouse position. 
 
Under the item "Edit" the spectral graph can be copied to the clipboard or saved as a bitmap 
file. Using these functions, it is possible to transfer the spectral display to a word processing 
program for documentation purposes. With the function "Copy data to clipboard" the 
measurement data are comfortably available for a spreadsheet. 
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11.3 Working with multiple spectra  
The SRpro software offers the possibility to display several spectra simultaneously. The current spectrum 
is always displayed with thicker lines. Bottom right appears  
 

 

 
Selection of the active spectrum  
Click on the  bottom right of the spectrum name to expand the list of open 
spectra. 

 

 
Figure 1: Selection list for active spectrum  
Select a spectrum from the list and click on the name. This spectrum is now 
taken over as the current spectrum. All displays, such as integral values and 
weights, are now displayed from this spectrum 

 

 

‚  
Delete a spectrum  
To delete a spectrum, select the spectrum as the active spectrum. Now press 
the button to the left of the name. This will delete the active spectrum from the 
memory.  

 

11.4 Symbol overview  
The toolbars provide grouped, context-sensitive access to the most important functions.  
The toolbar is the central control element for performing a measurement. Example: 

 

 
 
It is important to know about the functions of each switch and to check the correct setting before 
performing a measurement.  
 
 

 

 
Open spectrum  
Files from previous measurements can be selected and the spectra displayed 
on the screen. 

 

 

 
Save automatically  
All measurements can be saved automatically. The file name is given a three-
digit number at the end, which is increased by one for each measurement. So 
names like test001, test002, ... are possible. 

 

 

Save spectrum  
Only one measurement will be saved by entering a name. 
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Export spectrum 
It will save the measurement as an EXCEL file of the CSV file. See options  

 

 
Print  
Here the spectrum is printed. After the spectral diagram, the comment from 
the info window and the settings during the measurement are printed. The 
values from the displayed evaluation window (integration, weightings and 
color measurement) are also printed. 

 

 
Set printer  
Calls up the "Set up protocol" dialog. There you have the possibility to set the  
Customize the content of the PDF export. You can find a sample protocol in 
the appendix. 

 

 

 
PDF Export  
Saves the print output in a pdf. The included evaluations and data can be 
configured via the printer settings.  
A sample protocol can be found in the appendix. 

 

 

 

Integration time  
In this input window the integration time is set in milliseconds. Depending on 
the computer speed, the smallest possible value is 30 ms. If the spectrum is 
displayed incorrectly, the computer speed is too low for the integration time. 
Then select a longer integration time. 
With uncooled array the maximum reasonable integration time is between 
30000 and 60000 ms. With cooled array 60000 ms are always possible. Here 
the value Amax right under the spectrum window should be between 50% 
and just under 100%, otherwise the integration time should be changed. 

 

 

Start measurement  
Starts a new measurement with the set parameters. 

 

 

 
Dark measurement on/off  
Here you select whether the dark signal is to be determined before each 
measurement in a dark measurement with the same integration time and 
subtracted from the light measurement. Each photodiode array has a 
temperature-dependent dark current. This means that the photodiodes show 
a value greater than zero at large integration times, even at complete 
darkening. This effect can be fully compensated by subtracting a dark 
measurement from the measurement signal. We recommend, except for test 
measurements, to always switch on this item. 

 

 

 
Continuous measurement on/off  
With the set parameters, the measurements are made as fast as possible one 
after the other (i.e. as fast as the computer speed allows). In order to make a 
defined pause between two measurements, a corresponding time can be set 
in the "Settings->Device options" menu in the "Measurement interval" tab. 
With automatic save on, the number at the end of the file name is 
incremented. In the upper line a button "Stop" appears on the right, with 
which one ends the continuous measurement. 
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Automatic integration time on/off  
The button determines whether the integration time should be determined 
automatically. If the button is pressed, the program increases the integration 
time until the largest value of the spectrum is between 80 and 90 %. 

In the case of radiation sources operated with AC voltage, beatings can occur 
with the measurement time determined in this way, since parts of the period 
duration are not completely recorded. In this case, an integration time should 
be selected which is a multiple of the period duration. 

 

 

 
Transmission reflection measurement on/off  
Both transmission measurements and reflection measurements can be 
performed. For this purpose, two spectral images are taken in each case: first 
the measurement of the radiation source, then the measurement with 
specimen. For the reflection measurement, a reference standard is inserted 
during the measurement of the radiation source. 
Note that the division only produces meaningful values if the lamp also emits 
radiation in the corresponding spectral range. The noise increases strongly 
with decreasing intensity. 
 
For transmission and reflectance measurements, a baseline and dark 
measurement must be performed. These measurements must be repeated 
when changing the integration time, the number of averages or changing the 
light guide. 
 
For the same measurements, the 100% measurement (baseline) and the dark 
measurement can be saved automatically, so that they are not 
have to be performed again. Consequently, the measurement is faster. 
To do this, select in the menu Settings 
 
Baseline correction and USE 
Correct for dark 

 

 

 
Dynamic measurement on/off * 
The button "Dynamic measurement" determines whether several 
measurements are performed to improve the dynamics. If the button is 
pressed, 3 measurements are performed. The first measurement with the 
normal integration time, the second measurement with the 5-fold integration 
time and the last measurement with the 25-fold integration time. 
Subsequently, a spectrum is assembled from the three measurements.  

The measurements with multiple integration time are divided by a previously 
determined correction value. All values of a spectrum with increased 
integration time, which are smaller than 90% of the saturation value, are 
divided by the determined 

correction value 
and then fed to the 
further calculation. 

 
Dn = arithmetic 
mean of all 
correction values. 
The correction 
values are 
determined at the 
points where the 
intensity is 

t x25
spectra

spectra
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between 10% and 90%. 
 

ti = integration time 
 

Figure 2: The calculation of the dynamic spectrum  

 

 

 

Averages  
In the Averaging window, the number of averages performed during a 
measurement is specified. Averaging over several measurements can 
improve the signal-to-noise ratio. The value for averaging can be between 1 
and 65000. However, values between 10 and 100 are realistic in order not to 
make the total measurement time too long. If the value 1 is entered as the 
averaging number, no averaging is performed. 

  

 

 
Flash on/off (not available for all spectrometers) * 
By means of the switch Flash you determine whether trigger pulses are to be 
given to the output Flash during the measurement. The number of flashes 
depends on the integration time. The flash signals have a frequency of 100 
Hz. 

  

 

 
External triggering* on/off  
After starting the measurement via "  Start measurement" the following 
status window is displayed.  

 

 
Figure: Waiting for external trigger  
The activated trigger input is now monitored. As soon as the trigger signal 
comes, the measurement is started. If both trigger inputs are activated, a 
logical "or" operation is performed between the two inputs during evaluation. 

   

 

 
Spectral correction off  
The spectrum is referred to the level of the A/D converter. 100% means full 
modulation of the A/D converter. As soon as the A/D converter has full 
modulation at a point, the value of the spectrum is set to 100% at this point. 

 

 

 
Spectral correction relative  
The sensitivity of the spectrometer is not constant over the wavelength. This 
is due to the diffraction characteristic of the diffraction grating, the spectral 
sensitivity of silicon and the sensitivity differences of the individual 
photodiodes. Furthermore, the spectral response of the light guide and the 
other input optics used enters here. This wavelength dependence is 
compensated by assigning a correction value to each photodiode. Each 
measured value is multiplied by a correction factor. Thus, the calculation of 
color coordinates, color rendering indices and color temperature becomes 
meaningful. 

 

 Spectral correction absolute  
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The spectrum is given in physical units, e.g. µW/(cm nm) from this further 
quantities are calculated, e.g. irradiances & illuminances. At saturation, the 
values jump to the largest value of the spectrum that is not yet in saturation.  

 

 

Correction file  
The correction file used is displayed in the window. It must always be the 
file that belongs to the input optics used. 

 

 

 

Stray light correction 
From the measured spectrum you can subtract the offset that was determined 
in a certain wavelength range. To do this, enter the cutoff wavelengths of the 
range in which you want to determine the stray light component in the 
window. The stray light correction may be activated only if you know from a 
radiator that it has no signal in a certain range. In the later measurement, the 
average value that results in this range is subtracted from the measurement. 

After entering the wavelength range for the stray light correction, an offset 
correction factor can be specified. This factor is used to multiply the stray light 
offset before it is subtracted from the spectrum. The default value for the 
offset correction factor is 1. 
Stray light arises from diffraction at the entrance slit, from grating defects, 
from the 0th diffraction order at the grating, as well as all diffraction orders 
except the 1st order incident on the array, and finally from reflections at the 
array, window, and filter in front of the array. 

 

 
 

Calculator & Data Manipulation  
With this function you can manipulate the spectra. The basic arithmetic 
operations are possible. It is also possible to manipulate with constants. 
Constants are entered in the left under two input windows in the 
"Mathematics" window. If the result is to be displayed as a new spectrum, the 
name is entered in the lower right input window. 
 

 
Figure: The math window for data manipulation  
Please note that the spectra to be used must be displayed as marked in the 
figure. If they are only marked with a frame, the program does not recognize 
this selection. A corresponding message will be displayed.  

 

 

 
Information about current spectrum  
The instrument settings for the measurement appear in the information 
window. In addition, text lines for further information can be entered. The 
contents of this window are always output when printing.  
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Integral  
Irradiance values can be calculated under "Settings -> Evaluations". 

 

 

 
Weightings  
Weighted irradiances can be calculated under "Settings -> Evaluations" 
selected. 

 
 

 

 

Color coordinates  
The values specified in "Settings -> Evaluations" tab Colors are calculated 
and output.  

 

Window Settings Color 

 

 

 

  
Viewer  
The standard observer is set 2° or 10° according to the CIE.  

 

 

 

Color rendering indices  
If the color measurement is switched on, the color rendering indices can be 
calculated and output. Only the values specified in the "Settings -> 
Evaluations" tab Colors are output. 
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Color triangle  
If the color measurement is switched on, the position of the color location in 
the CIE 1931, CIE 1960 or CIE 1976 color triangle can be displayed in the 
corresponding color triangle. 

 

11.5 File menu  
Other settings are available via the menu that have not already been described as an icon. The menu is 
shown below: 

 

 
 
It is possible to save and load an existing settings file. In a settings file (*.ssf), all settings such as 
integration time, averaging, dark measurement, integration ranges, etc. are saved. The use of settings 
files is especially useful if you have to perform different measurements again and again. 
 
Switching the program language is possible between German and English. After the language change, 
all menu items are displayed in the new language and this is permanently saved. 
 

11.6 Window menu  
Other settings are available via the menu that have not already been described as an icon. The menu is 
shown below: 
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The menu items in detail: 

  
 

If this function is checked, the graph will be adjusted each time it is 
redrawn to make maximum use of the spectral graph. 

 
Zooms into the predefinable areas 

 
If this function is selected, the ordinate of the graph is scaled 
logarithmically. 

 
Displays the CIE color triangles 

 
 

11.7 Analysis menu  
Other settings are available via the menu that have not already been described as an icon. The menu is 
shown below:  
 

  

 
 

 

 

With the point "Analysis" an option window is opened. In this window 4 
tabs are available, in which settings for the evaluation of the spectra can 
be made.  

   
The start and end wavelengths of the display are defined under the "Spectrum" tab. The unit to be 
displayed can be selected here and will be converted automatically. "Fill Graph" fills the area under 
the spectrum in the output. 

 

 
In the "Irradiances" tab, you can switch the calculation of the standard integrals on or off. Also a 
calibration of the integral is possible. 
Furthermore, 4 user integrals are available. As soon as you switch on a user integral, the 
calibration factor and the start and end wavelength of the integral are enabled. 
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In the " Actinic irradiances" tab, the default weights are 
LUX (V(lambda), erythema weighting and pigment weighting provided. 
 

 
User weighting files can be selected for User1 to User4. These files must exist in the WEIGHTS directory 
and have the file extension GEW. If a user weighting is switched on, the existing weightings are 
displayed in the corresponding file selection list. The weighting file has the following structure: 
 
The LUX (V(Lambda) weighting, erythema weighting and pigment weighting are usually provided in the 
“Weightings” tab. For User1 to User4, user weighting files can be selected. These files must be available 
in the WEIGHTINGS directory and have the file name ending GEW. If a user weighting is switched on, 
then the available weightings are displayed in the corresponding file selection list. The weighting file has 
the following structure: 

 
The weighting files are ASCII files, which show the weightings in the Real format, followed by a [CR] 
character. The weightings start at 200 nm and end at 800 nm. The step size between the individual 
values is 0.6 nm. 

E.g. 
[Real value] [CR]                        6.0754321E-002 
[Real value] [CR]                        5.3765211E-002 
      .                                       . 
      .                                       . 
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[Real value] [CR]                        1.5987988E+001 
 

The file names ERYTHEM.GEW, LUX.GEW and PIGMENT.GEW are standard weightings. Any 
names can be used for the user functions (e.g. USER1.GEW – USER4.GEW). 

 
 
The "Colors" tab allows to show/hide color relevant calculation data (color coordinates, color 
temperature, distance from the Planck train for the 2 degree and the 10 degree observer 
respectively). 
 

 
 

In the "Wavelength" tab, you can set the peak wavelength, the dominant 
Display the wavelength and the center of gravity wavelength. 
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11.8 Options menu  
Other settings are available via the menu that have not already been described as an icon. The menu 
is shown below:  

  

 

 
 

 

 

After clicking on "Options" a window is opened which contains further 
tabs. These tabs can be used to define device settings. 

 

The "Path" tab can define the directories to the files used. These directories are created and entered 
during the installation. However, if you have different directories, the change is possible here. 

 
 
The "Measurement" tab allows to change the pause between two measurements in case of 
continuous measurement. If the check mark is removed, you can change the pause between two 
measurements between 1 and 300 seconds using the slider 
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In addition, the baseline (for 100%) and the dark measurement can be saved for transmission and 
reflection measurement so that the same settings do not have to be measured again. To do this, select 
"Create baseline ..." and "Use" respectively 
 
The stray light correction is selected via "Manual Range" or Auto. In the manual range, an offset 
determined in a certain wavelength range can be subtracted from the measured spectrum. To do this, 
enter the cutoff wavelengths of the range in which you want to determine the stray light component in 
the menu. The stray light correction may only be activated if you know from a radiator that it has no 
signal in a certain range. In the later measurement, the average value that results in this range is 
subtracted from the measurement. 
After entering the wavelength range for the stray light correction, an offset correction factor can be 
specified. This factor is used to multiply the stray light offset before it is subtracted from the spectrum. 
The default value for the offset correction factor is 1. 
Stray light arises from diffraction at the entrance slit, from grating defects, from the 0th diffraction order 
at the grating, as well as all diffraction orders except the 1st order incident on the array, and finally from 
reflections at the array, window, and filter in front of the array. 
 
 
The "Auto" option corrects the stray light by evaluating and subtracting the first pixel. 
 
 
 
General settings can be made in the "Settings" tab. For example, the start screen can be hidden or 
the search for the spectrometer at program start can be prevented. Also the possibility to output a 
sound after the end of a measurement can be switched on here. 
 

 
 

In the "Threshold" tab, how to define the range of a valid measurement based on the level. If the 
level of the measurement is within the thresholds, the measurement is evaluated as OK in the PDF 
protocol for (standard) users. Note: For power users there is no evaluation. 
 

Recommended settings: 30% to 90% 
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In the "Users" tab, it is possible to switch between the restricted (default) user and the main user 
once or permanently. 
 
Enter the password for the main user and confirm with "Save user" to activate the main user 
permanently, i.e. at every system start. 
 
Note: The default setting is restricted user. For one-time setting changes, it is sufficient to enter the 
password. In this case, do not click on "Save user". 
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In the "Export" tab, the export function can be parameterized. Available are:  
- The wavelength range 
- The interpolation distance (interpolation points) 
- The path 
- File format. 

 
Note: Microsoft EXCEL 2010 or later must be installed for EXCEL export. 
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11.9 Edit menu  
Under the item "Edit" the spectral graph can be copied to the clipboard or saved as a bitmap file. 
Using these functions, it is possible to transfer the spectral display to a word processing program for 
documentation purposes. With the function "Copy data to clipboard" the measurement data are 
comfortably available for a spreadsheet. 
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11.10 Calibration menu*  
With the delivery of the spectrometer you will receive the calibration file as well as a calibration 
certificate. This calibration data must be transferred to the software in order to obtain an exact 
measurement. 

 
It is nevertheless possible to calibrate the spectrometer itself to absolute irradiances via the 
"Calibration" menu item. A relative display of the spectra is still possible despite absolute calibration. 
The setting of the desired correction type is done via the toolbars. The spectrometer is calibrated at 
delivery. To increase the accuracy of the measurement result, the program has the possibility to 
perform its own calibration. For this purpose, a standard lamp or two standard lamps with spectral 
characteristics guaranteed by the manufacturer are required. The calibration is performed by default 
in the range of 
360-800nm with a halogen lamp and in the range of 200-360 nm with a deuterium lamp. If only one 
measuring range is required, a partial calibration can also be performed. In this case, the calibration 
of the other range remains active. The link point at which the two partial calibrations are joined can 
be shifted from 360 nm to any position in the spectral range. The calibration procedure for a range is 
described below. 

 

 

After calling up the menu item "Calibration", a security query is first 
carried out. 

 
  This safety query is performed because an accidental change of the calibration values is not reversible 
when the subsequent window is closed with "Next". A calibration measurement cannot be reversed 
under any circumstances. 

 
 
If an existing calibration file is overwritten by the calibration measurement, this is not 
reversible. 
If you do not have the equipment (measured calibration lamp, deuterium lamp, ...) for the 
calibration, please cancel the confirmation prompt by pressing the "Cancel" key. 
 
After the security prompt, you are in the "Serial number" tab. Enter the serial number of your device 
here. You will find the serial number on the back of the device. As soon as you have entered the serial 
number, a check is made in the parameter files to see whether your device is already registered. If 
this is not the case, a corresponding message will be displayed and you can register your device 
again. If your device is already in the list, the settings for your device are loaded. 
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(SR600 only) 

 
Now switch to the "Move" tab. 
In the "Displacement" tab you have two setting options: 

• Start diode: 
By changing the start diode number, the position of the spectrum is changed. A fine 
calibration of the wavelength assignment is possible via this value. 

• Dispersion: 
Dispersion sets the spread of the spectrum. This value also influences the wavelength 
assignment. 

Only change both values with the greatest care. Make a note of the set values before changing them. 
After making changes, always take measurements again and evaluate the result. Please note that the 
window is not displayed modally. I.e. you can use the "Start measurement" icon of the main window at 
any time without closing the window.  
The mercury lines at 253.6 nm, 577.0 nm and 579.0 nm are well suited for setting the start diode 
number and dispersion. Very good values can be achieved by successively changing the start diode 
number and dispersion.  

 
When you are satisfied with the wavelength assignment, please switch to the "Spectral Response" tab. 
Course" tab. 

 
In the register "spec. Course" the spectral sensitivity of the receiver is corrected. The 
calibration lamps are required for this. The register has the following setting options: 
 

• Link wavelength:The  
link point of the two partial calibrations can be set here.  
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• Unit: 
Here the unit can be changed. This function allows, for example, to change the 
calibration to Anglo-Saxon units of measurement. 
 

• Standard file for the upper range: 
File name of the standard file for the range from the link wavelength to 800nm. The 
structure and generation of the standard file is explained in chapter 11.11.  
 

• Norm file for the lower range: 
File name of the norm file for the range from 200nm up to the link wavelength. The 
structure and generation of the standard file is explained in chapter 11.11. 
 

Target file:The  
file name for the calibration file to be created can be specified here. Please check if the file already 
exists. If necessary, use date coding in the file name to avoid accidentally overwriting an existing 
calibration file.  
 
The actual calibration measurement is started with the "Calibration" button. The parameters of the 
measurement are taken over from the main window. First, it is checked whether the target file already 
exists. If it is available, it will be loaded. This serves for the fact that with partial calibrations 
automatically the other partial range is taken over. If the target file is not available, the following 
message is displayed. 

 

 
 
The target file is then recreated and all values are set to zero. The query for the upper spectral range 
then takes place. If the calibration measurement for the upper spectral range is to be skipped, this can 
be done by pressing the "Cancel" key. 

 

 
After confirming with "OK", the correction measurement for the upper spectral range is performed. The 
calibration file is then calculated from the raw data in such a way that the raw data multiplied by the 
calibration file results in the standard file for the upper spectral range. Values in the calibration file that 
are below the link wavelength are not changed by this process. 

 

 
Subsequently, the measurement for the lower spectral range takes place. After the measurement, the 
values are adjusted so that the correct measured value is present at the connection wavelength. 
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After calibration has been completed, switch to the "Absolute Intensity" tab. 
 

 
 
In the "Absolute Intensity" tab, you can correct the absolute intensity. This may be necessary if you 
have been given the absolute intensities and the irradiance at a certain distance for your calibration 
lamp but have not carried out the calibration at this distance. Then you can e.g. determine the 
irradiance ratio between target and actual irradiance at the nominal position and calculate it into the 
correction file with the button "Perform correction". The target file from the "Spectral course" tab is 
used as the correction file. Course" tab is used as the correction file.  

 
10.8 Handling and saving the calibration files 
To complete the transfer of the calibration, the calibration files must still be transferred. 

 

 
With the delivery you will also receive the calibration files. These calibration files (*. SpecCal) must 
be copied to the corresponding directory (default: C:\ProgramData\SR600 \SpecCal). Use the 
Windows Explorer for this purpose. 

 
If this path does not exist on your computer, you can look up the path for the calibration files in the 
menu item "Settings -> Device options" tab sheet "Directories". 

 
 

 
 

Please copy the calibration files, then into the appropriate directory. 
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If protection against accidental manipulation or handling of user rights is 
desired, change the Windows security settings to "Deny folder contents", 
as shown below as an example: 

 

 

 

If protection against accidental manipulation or handling of user rights is 
desired, change the Windows security settings to "Deny writing" as shown 
below as an example: 
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11.11 Standards files  
With the optional program NormFile ASCII files are converted by linear interpolation into a standard 
file for the calibration measurement. The step size as well as the start and end values of the source 
data are arbitrary. The source ASCII file must have the following format: 
 

E.g. 
[step size in nm] [CR]  5 
[initial wavelength in nm] [CR] 300 
[terminal wavelength in nm] [CR]  900 
[Real value] [CR]    4.95029144673026E+0001 
[Real value] [CR]    5.10178270335309E+0001 
.     . 
.     . 
[Real value] [CR]    5.10178270335309E+0001 
 

Press the Open button to land a corresponding source file. The step size, the start wavelength and the 
end wavelength will be displayed in the left fields.  
Now you can change the step size and the wavelength range for the target data in the right input 
fields. These depend on the type of instrument used. For the standard spectrometer, these are already 
predefined. 
Now press the "Save" button. The program then performs the interpolation and sets target values that 
could not be interpolated to 0. This is the case if the wavelength range of the source file does not 
cover the complete wavelength range of the target file. After the interpolation, the file name can be 
entered in a selection window. Please note that the program SPEKTROMETER.EXE can only process 
files of the type .DAT. Therefore you should always enter the type .DAT at this point. The standard 
files must be located in the subdirectory KOR. 
 
ATTENTION! An already existing file will be overwritten without confirmation. Therefore, backup 
copies should be created. 
 
The destination file has the following format. 
 

e.g. Halnorm.dat 
 
[Number of spectra(always 1)] [CR]        1 
[Real value] [CR]                    4.95029144673026E+0001 
[Real value] [CR]                    5.10178270335309E+0001 
       .                                        . 
       .                                        . 
 [Real value] [CR]                   5.10178270335309E+0001 
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12 Technical data  

 

Spectral ranges 
Classification of spectral ranges According to CIE 

UV-C 200 - 280 nm 

UV-B 280 - 315 nm 

UV-A 315 - 400 nm 

VIS 380 - 780 nm 

 

General data SR600 
Dimensions (L x W x H)  145 x 260 x 315 mm  

Weight  approx. 6.8 kg  

Supply voltage  110 -230 VAC  

Power consumption  15 W  

Ambient temperature +5 to 40 °C 

Storage temperature, approx. -10 to +50 °C  

Humidity 0% to 80% rel. humidity 

Cooling  Air cooling 

 

Radiometric measurements SR600 
Spectral range  200 - 800 nm ±2nm  

Spectral bandwidth  1.2 nm to 4 nm  

Sampling Rate  7 ms - 60000 ms,  
automatically and manually adjustable  

Cosine correction  yes  

Calibration  yes, traceable to PTB  

Calibration interval-, recommended  12 months  

 

Mounting position, minimum distances 
Body position  horizontal 

Minimum distances, top  2 cm  

Minimum distances, lateral 2 cm 
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Optical parameters SR600 
Focus  140mm  

Aperture  F/2  

Grid  holographic concave grating, flat field type  

Line count  285/mm  

Dispersion  24 nm/mm  

Step size  0.6 nm  

Blaze wavelength  250 nm  

Digital resolution  16 bit  

Dark current at 20°C  ti = 60sec < 45%  
ti = 6sec < 4.5%  
ti = 0.6sec < 2.0%  
The dark current must be compensated during the 
measurement.  

Shutter  integrated  

Measuring frequency  max. 33Hz (30ms/spectrum)  

Graphic structure  up to 2 frames/s (continuous measuring mode 

Fiber optic cable connection Fiber optic cable connection 

Fiber optic cable connection, bending 
radius 

> 200 mm 

 

Array SR600 
Array type  linear silicon photodiode array  

Pixel count  1024  

Pixel height  2.5 mm  

Pixel width  25 μm  

Receiver length  25.6 mm  

Sensitivity  200 - 1000 nm (10% of the max. value)  

Dynamic range, an integration time  Type. 4000 : 1  

Dynamic range, max  10^5  

Sensitivity uniformity  +/- 3 % typical  

Saturation charge  Type. 25pC  
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Connection SR600 
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General data SR900 
Spectral range  200 - 1100 nm  

versions:  measurement range  

Standard  ~ 1 - 200 mW/cm²  

High-Sensitive  ~ 0,01 - 10 mW/cm²  

High-Power  ~0,01 - 10 W/cm²  

Spectral resolution  0,44 nm (pixel pitch)  

Spectral bandwidth  2,3 nm (FWHM)  

Gratting  300 l/mm, holografic  

Focal length  75 mm  

Blaze wavelength  250 nm  

Detector  SI  

Pixel size  14 x 200 μm  

Number of pixel  2048  

Resolution  16 bit  

Integrations time  0,1 ms to 60 s  

Max. Dynamic range  105:1 with 3 measurements  

Interface  USB  

Trigger  rear connection  

Dimensions  177 x 125 x 45 mm  

Weight  1.2 kg  

Supply voltage  5 V, 500 mA  

Power  < 3 W  

Operating temperature  5 to 40 °C  

Storage temperature  -10 to 60 °C  

Humidity  <80%, non-condensating  

System requirements  Win 7/10, min 1 GB RAM  
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1 Spare parts , calibration and maintenance  

 

When ordering spare parts, please contact: 
 
Opsytec Dr. Gröbel GmbH 
Am Hardtwald 6-8 
76275 Ettlingen 
Germany 
Phone +49 - 7243 - 94 783 - 50 
Fax +49 - 7243 - 94 783 - 65 
 
Visit us on the Internet: www.opsytec.de 

 
 
 
 
 

http://www.opsytec.de/
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14 Declaration of Conformity 
 

 
Manufacturer :  
 

Company name: Opsytec Dr. Gröbel GmbH 
Street: Am Hardtwald 6-8 
City: 76275 Ettlingen 
Country: Deutschland 
 

Person authorized to compile the technical 
documentation  

Company name: Opsytec Dr. Gröbel GmbH 
Street: Am Hardtwald 6-8 
City: 76275 Ettlingen 
Country: Deutschland 
 

Product:  Spektrometer SR600 with Software SRpro 
Spektrometer SR900 with Software SRpro 

 
Type designation:  
 

 
SR600 / SR900 / SRpro 

The manufacturer hereby declares that we have developed, designed and manufactured the above 
product(s) under our sole responsibility and that the product complies with the following standard(s) or 
directive(s) in this declaration: 
 
2014/35/EU  
“Directive of the European Parliament and of the Council on the harmonization of the laws of the Member 
States regarding the provision of electrical equipment for use within certain voltage limits on the market 
(Low-Voltage Directive)“.  
 
2006/42/EG  
“Directive of the European Parliament and of the Council on machinery and amending Directive 95/16/EG 
(Machinery Directive)”.  
 
2014/30/EU 
Directive of the European Parliament and of the Council relating to electromagnetic compatibility (EMC 
Directive, recast)". 
 
Ettlingen, 19.10.2019 
 
 
gez. Dr. Mark Paravia 
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